
Not long to go now…  Just a reminder, this almost-two-day virtual 
conference, for charity, presents 50 Excel, Data Platform and PowerPoint 
MVPs, together with other acknowledged experts from Microsoft and 
/ or around the globe to present, answer questions and demonstrate 
the future of Excel and how it will make your life easier, personally and 
professionally.

Topics will include: Charts, Dashboards, Data Analysis, Data Types, 
Excel Tricks & Tips, Financial Modelling, Forecasting, Maps, Microsoft 
365, New Functions and Features, Office Scripts, PivotTables, Power BI, 
Power Pivot, Power Query, Presenting Your Data and VBA.  It’s not all 
in English either, with some sessions in French, Portuguese and Spanish 
(albeit not many!).

Each session (including Q&A) will last no more than an hour and topics 
will cover all expertise levels, from novice to expert.  Most presenters are 
well known in their spheres, and have written blogs, books and articles 
and / or present video sessions.

Most sessions will be recorded so you may watch them later with 
downloads aplenty – there are no medals for staying up to watch the 
entire event live!  That’s just as well, as it will run from 23:00 GMT / UTC 
on Monday 11 October to 20:59 GMT / UTC on Wednesday 13 October.  

From your own favourite chair, bring a laptop, an inquisitive mind and 
your sense of humour.  Be prepared to learn heaps.  And remember, 
it's for charity – this year, there is no ticketing process: all we ask is an 
“honesty box” where you donate to your favourite charity.

For more details (e.g. times, speakers, sessions), please go to  
www.excelvirtuallyglobal.com.  

Hopefully, we’ll see you there!

NEWSLETTER #107 - October 2021

It ’s almost time for Excel Virtually Global – The Sequel   
Find out all the details about how you can view circa two days content from some of your favourite Excel, Power BI and PowerPoint 
presenters on the planet.  Oh, and I will be doing it too!  Don’t forget to give to charity!

We say goodbye to User Voice, Silverlight and Power View, but no matter; we have time to look at notes on Excel for the web, as well as all 
the usual blarney, with another Beat the Boredom Challenge, plus Charts & Dashboards, Visual Basics, Power 
Pivot Principles, Power Query Pointers, Power BI updates, Keyboard Shortcuts and we strive for GROWTH in 
this month’s A to Z of Excel Functions.  

As always, happy reading and remember: stay safe, stay happy, stay healthy.
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Goodbye Excel User Voice

Power View Goes into Retirement

Regular readers will know we frequently extol the virtues of Excel UserVoice.  Well, alas, ‘tis no more:

Silverlight, a component used in Power View, will no longer be supported 
beginning on October 12th.  Furthermore, Microsoft will be starting the 
process to retire Power View from Microsoft 365 too.  As an alternative 

to Power View, of course you should be using Power BI Desktop, which 
is where Microsoft continues to develop 20,000 updates a month (see 
later in this newsletter!).

Microsoft had partnered with UserVoice, a third-party service, to communicate with customers and collect feedback.  However, the software giant 
had previously advised that they were moving away from all UserVoice feedback sites on a product-by-product basis throughout the 2021 calendar 
year.  Sadly, it’s now Excel’s turn.  

So what do you do now?  Do they want feedback?  Apparently, customers can continue to communicate with Microsoft and provide feedback 
through a number of different channels – what they refer to as “first party solutions” (a cost reduction program?).  Examples include: 

	 •	 in-product experiences (e.g. Send a Frown)
	 •	Windows Feedback Hub
	 •	Microsoft Tech Community
	 •	Microsoft Store.

The official line is that Microsoft is “…evaluating enhancements and standardizations (sic) to improve and streamline how [they] communicate with 
customers and collect their feedback…”.

Alas, poor UserVoice, we knew you well.
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Comments and Notes Upgraded in Excel for the Web
There have been some recent updates to the threaded comments 
and notes experience in Excel.  When what was known as “threaded 
comments” in Excel for Windows, Excel for Mac and Excel for the web 
was released back in January 2019, Microsoft originally decided to keep 
the legacy comments (the yellow sticky notes) in the Windows and 
Mac versions and rename them notes.  However, it has become cleat 
that notes and comments serve different purposes, and that Microsoft 

needed to support both in order to address different user scenarios  
(e.g. conversations vs. annotations).

The problem was, when threaded comments were introduced, the 
ability to create notes in Excel for the web was removed.  This meant 
that notes created in the desktop version looked and worked differently 
in Excel on the web, e.g.

	 •	Notes on the web did not appear when hovering over the in-cell indicator.  It required the user to hover and click an on-object user interface 	
	 	 (UI), which would open the note in the Comments pane  

	

	 •	Notes on the web did not appear as yellow sticky notes.  Instead, they took the form of threaded comments.  When users attempted to edit 	
	 	 or reply to a note, they would be required to first convert the note to a threaded comment

	 •	 You could create new threaded comments on the web, but not new notes.

For reference, here is how comments and notes appear presently in Excel for Windows:

This is used for conversations.

This example is used make annotations or share instructions.
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To counter this, Microsoft has instigated some important steps to 
address these inconsistencies and improve the overall user experience 
with notes and comments in Excel for the web.  With this borne in mind:

	 •	 Threaded comments and notes may now display as floating  
		  objects.  Excel for the web now supports floating notes on the  
		  grid, and notes have also been moved out of the Comments pane.   
		  Now, when you hover over the in-cell indicator, notes (and  
		  comments) will float on the grid, directly aligned to the cell they  
		  are related to

	 •	 The notes have been updated to look like notes (rather than  
		  threaded comments).  Comments and notes each have their  
		  own familiar UI.  The notes on the web have been revised to  
		  look and feel like those created in Windows and Mac.  Now,  
		  when you create a note in either, it will render as a yellow sticky  
		  note on the web.  When viewing notes on the web, there will no  
		  longer be confusion as to whether the object is a note or a  
		  comment

	 •	 The functionality to create both threaded comments and notes  
		  on the web is now fully supported.  There is now the ability to  

		  create yellow sticky notes in Excel on the web.  This means you  
		  may choose the optimal solution for your specific scenario.

Working with comments and notes across Windows, Mac and the web is 
simple.  On the Review tab, you can:

	 •	 select ‘New Comment’ to create a comment.
	 •	 select ‘New Note’ to create a note.

It should be noted that you may also right-click the cell you want to place a 
comment or note on, then use the shortcut menu to accomplish the task.

Other commands related to comments and notes are also found on the 
Review tab, allowing you to show or hide notes or comments, move to 
the next or previous item, convert notes to comments, etc.

To explore the improved functionality of notes and comments in Excel 
for the web, try the following:

	 •	View desktop notes on the web.  This may be achieved by  
		  creating a note in Excel for Windows or Excel for Mac.  You should  
		  note that when you view the note in Excel for the web, it appears  
		  on hover and looks like the yellow sticky note you are familiar with

	 •	Create a note on the web.  Excel now supports the creation of both comments and notes on the web.  To create a yellow sticky note, select 	
	 	 Review -> New Note.  (You may also right-click a cell and select ‘New Note’ in the shortcut menu)

	 •	Manage notes on the web.  When you select a cell that contains a note, you can right-click it and choose a command to edit, show / hide, 	
	 	 delete or convert the note to a threaded comment.  Using the Notes button on the Review tab, you can create new notes, navigate through 	
	 	 all notes with the next and previous commands and convert all notes to threaded comments
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	 •	Show all notes on the grid.  To see all your notes on the grid, select Review -> Notes -> Show All Notes

	 •	See all notes and all threaded comments.  If you want to see all your notes and all your threaded comments at the same time, select Review  
		  -> Notes -> Show All Notes, and then select ‘Show Comments’ to open the Comments pane

	 •	Convert a note to a threaded comment.  If you have created a note in a cell and want to start a conversation or @mention someone, you 	
	 	 need to convert the note to a threaded comment.  Simply select and right-click the cell with the note you want to convert, choose ‘Convert 	
	 	 Note’ in the shortcut menu, and then click the ‘Convert’ button confirm the action.  The note becomes a threaded comment, and you can now 	
	 	 start a conversation, @mention others and send notifications

When threaded comments were introduced with the legacy comments 
renamed as “notes,” it was noted that many would want to continue to 
use the notes with the usual keyboard shortcuts.  Therefore, the legacy 
comment shortcut (SHIFT + F2) has been retained to create a note.  

Further, Microsoft is also introducing a new keyboard shortcut to create 
a threaded comment: CTRL + SHIFT + F2 (COMMAND + SHIFT + F2 on the 
Mac).  However:
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	 •	 on cells that already contain a note, pressing SHIFT + F2 will put the note in Edit mode
	 •	on cells that already contain a threaded comment, pressing CTRL + SHIFT + F2 (COMMAND + SHIFT + F2 on the Mac) will open the comment 	
	 	 and put the focus in the Reply box.

Whilst notes in Excel on the web work much like notes have always worked in Excel for Windows and Excel for Mac, there are still a few differences 
and areas to be aware of.  In particular, notes in Excel on the web:

	 •	 do not support rich text formatting, background colour or images
	 •	 cannot be repositioned on the grid
	 •	may be shown, hidden and resized, but for a given user session only.  Other co-authors will not see these formatting changes.

The above features are being released over some time to ensure things are working smoothly.  If you don’t have these features yet, don’t worry, 
they’re coming!!

Often, we receive data that isn’t in the best of shape.  It may have text and numbers intermingled and you wish to separate (i.e. space) them out.  
For example, you might want “Pelham123” to be “Pelham 123”, or require “121Training” to be “121 Training”.  

Where there is just the one change of data type in the text string, it’s possible to create a reasonably straightforward formula, but things get harder 
with multiple occurrences.  And that’s what this month’s challenge is – fix the issue in general.

Using your favourite search engine will typically yield third party add-ins, VBA (e.g. User Defined Functions) and Power Query solutions – all NOT 
allowed here!

This month’s challenge is to construct an Excel formula that will split out multiple occurrences of numbers and text, e.g.

Sound easy?  Try it.  One solution just might be found later in this newsletter – but no reading ahead!  

Beat the Boredom Challenge

Charts and Dashboards

With many of us currently “working from home” / quarantined, there are 
only so Zoom / Teams calls and virtual parties you can make before you 
reach your (data) limit.  Perhaps they should measure data allowance 
in blood pressure millimetres of mercury (mmHg).  To try and keep our 

readers engaged, we will continue to reproduce some of our popular  
Final Friday Fix challenges from yesteryear in this and upcoming 
newsletters.  One suggested solution may be found later in this newsletter.  
Here’s this month’s…

It’s time to chart our progress with an introductory series into the world of 
creating charts and dashboards in Excel.  This month, we look at Bar charts.

By definition, a Bar chart and a Column chart are both members of the 
bar chart family.  Excel differentiates them by classifying a Bar chart as 
one where the bars are horizontal and therefore the categories are on 

the vertical axis and the value range is specified on the horizonal axis.  
A Column chart, which was discussed in last month’s newsletter, has 
vertical bars and the axes are obviously the other way around.

Just like for the Column chart, Excel provides a number of Bar chart 
variations, including Clustered and Stacked formats in 2-D and 3-D:
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Reusing last time’s sales data by customer group,

I can create a Bar chart such as the one below:  

Initially, it looks the same as the Column chart, but upon further analysis, there are a few differences which might, and will in this example, require 
altering. 

Below is the Column chart generated from the data (from last month):

First, notice the bars for each income type series are touching in the 
default settings, whereas there were gaps between them in the Column 
chart.  Also, the income types on the vertical axis are in the wrong order.  
This is because Excel considers the bottom left corner of the chart to 
be the ‘starting point’ for the Line chart, Column chart, Bar chart and 
most others that have a single horizontal and vertical set of axes.  As 
such, working from this corner, Collection is the first income type, so 

it appears closest to the ‘starting point’ then working upwards, next 
is Warehousing, etc. Finally, note that the legend is also backwards 
compared to how it appeared for the Line chart and Column chart.

To change the order of the vertical axis, I select it, right click and choose 
‘Format Axis’.  Under the ‘Axis Option’, tick the ‘Categories in reverse 
order’ checkbox.
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This will correct the order but now there is something weird: the horizontal axis is at the top, as this is where our first category is now located. 

To fix this, I click on the axis and select ‘Format Axis’ once again.  Under the ‘Horizontal axis crosses’, I tick ‘At maximum category’, which is Distribution. 
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Also note that the above steps have also switched the legend around, putting BizSupplies first and Other Clients last, which is the order I happen to 
prefer.

To create the gap between the columns within each income type, I select any of the data series on the chart, right click and choose ‘Format Data Series’.  
Under ‘Series Options’, there is ‘Series Overlap’.  By setting this to be a negative value, this will separate the individual columns from each other.

Now my chart looks fine:
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However, chart variations can sometimes communicate more information.  For example, instead of using the Cluster type chart, I can change this 
into a Stacked chart, by clicking on the chart, then under the Design tab of ‘Chart Tools’ in the Ribbon, I choose ‘Change Chart Type’.  In the ‘Change 
Chart Type’ dialog, I choose ‘Stacked Bar’:

The chart now appears as follows, showing the total income from each activity as well as the client breakdown:

The other Bar chart variation is the 100% Stacked Bar, which shows the percentage of income from each client by activity type:

Finally, I do some further formatting similar to last time’s Column chart, and then I have a more “vivid” Stacked Bar Chart, viz.

More next month…
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Visual Basics
We thought we’d run an elementary series going through the rudiments of Visual Basic for Applications (VBA) as a springboard for newer users.   
This month, we continue looking at using ListObjects.

Warning! This was written whilst listening to a New Order playlist and 
Adele is making a comeback from last month’s newsletter to show the 
various parts of a table.

Last time out, we experienced the “Ecstasy” of being able to refer to a 
Table, but now it’s time to play with its components “All Day Long”. 

Here, we will specifically explore the  concept of the ranges.  The Range property covers the entire Table and all the properties that apply to ranges 
apply to it.

It’s “Fine Time” that the whole table is considered.  What is the “Vanishing Point” of a table?

By using the Range.Delete method, the whole table can be removed in one fell step.

After a quick “Run” of that script, “Everyone Everywhere” would not be able to find trace of the table.
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However, there is a more direct way to completely remove a table.  It might be “Academic” but works just as well and a lot less ambiguous – delete 
the ListObject directly!

Before you can express any “Regret” over losing data and “Run Wild” deleting ListObjects, what if the table structure is to be removed but not the 
actual data itself?  How do you convert from Table to a range, as if the ‘Convert to Range’ button were clicked on the Ribbon?

Take a “Turn” with the Unlist method of ListObject.
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Before:

After:

“Hey Now What You Doing?”  The Table structure has been successfully converted and all filters have been removed yet the formatting has remained 
the same. 

More next time.

Power Pivot Principles	
We continue our series on the Excel COM add-in, Power Pivot.  This month, we introduce the CLOSINGBALANCEMONTH function.

CLOSINGBALANCEMONTH is a time intelligence function similar to the DATESYTD (you can read about the DATESYTD function here.  The 
CLOSINGBALANCEMONTH function, like all time series functions, requires contiguous dates to work properly. 

The CLOSINGBALANCEMONTH has the following syntax: 

CLOSINGBALANCEMONTH(expression, dates[, filter])

The CLOSINGBALANCEMONTH function can be used to generate balance sheet values, as we want to view the inventory balance at the end of a period. 

We have the following inventory table containing T-Shirt data from the months of January 2017 to June 2017.  Do note, for simplicity’s sake our 
example table already contains contiguous dates. 
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After importing the table into Power Pivot let’s create a measure using the CLOSINGBALANCEMONTH function:

The next step is to create the following PivotTable:

The PivotTable now displays the inventory closing balance amount at the end of the month. From here we can use these values for our financial 
reports. 

More Power Pivot Principles next month.

Power Query Pointers
Each month we’ll reproduce one of our articles on Power Query (Excel 2010 and 2013) / Get & Transform (Office 365, Excel 2016 and 2019) from  
www.sumproduct.com/blog.  If you wish to read more in the meantime, simply check out our Blog section each Wednesday.  This month, we take a look 
at how to reference a cell in an Excel workbook from Power Query.

Let’s begin by creating a query from the item data below:
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On the Data tab, in the ‘Get and Transform’ section, we’ll choose to create a new query ‘From Table’.

This all looks fine, but now let’s add the ‘Grand Total’ from another sheet in this workbook.
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Our first step is to name this cell using the Name Box (highlighted above, currently displaying the cell K5).  We’ll call it ‘Grand_Total’.

Now, go back to our query, and choose to create a ‘Custom Column’ from the ‘Add Column’ tab:

Here, enter the following formula:

Excel.CurrentWorkbook(){[Name="Grand_Total"]}[Content]{0}[Column1]

When you click ‘OK’, a new column is added:

This method works for character and numeric cells (including dates).

More next month!

Power BI Updates
This month’s updates see new improvements for buttons, line charts and DAX functions, amongst other updates.  Also, Insights is new this month and 
Microsoft has added some new capabilities for Goals.  The full list reads as follows:

mailto:contact@sumproduct.com
http://www.sumproduct.com


contact@sumproduct.com  | www.sumproduct.com  | +61 3 9020 2071 

Reporting

	 •	 New formatting options for buttons
	 •	 Toggle total columns in waterfall charts
	 •	 Line chart series labels
	 •	 Sensitivity label support for Power BI template files

Analytics

	 •	 Insights (Preview)

Modelling

	 •	 Shortcut expression for CALCULATE now supports aggregation 	 	
	 	 functions
	 •	 New parameter for XIRR function
	 •	 Making it easier to format based on a user’s locale

Data Connectivity and Preparation

	 •	 Power BI Connector in Power Automate is now Generally Available
	 •	 AssembleViews now Generally Available
	 •	 Azure Databricks (connector update)
	 •	 Bloomberg Enterprise Data and Analytics now Generally Available
	 •	 DataVirtuality (connector update)
	 •	 Exasol (connector update)
	 •	 Vena now Generally Available

 
 
 
 

Service

	 •	 Power BI Goals: automated status rules (Preview)
	 •	 Power BI Goals: improved filtering (Preview)
	 •	 APIs to determine who has access to what Power BI artifacts 	
	 	 (Preview)
	 •	 Service Principal support for read-only Admin APIs now Generally 	
	 	 Available

Mobile

	 •	 Goals now available in Power BI Mobile apps
	 •	 Explore content that’s relevant to you (Android and iOS)
	 •	 Now you can request access to reports from your mobile app

Developers

	 •	 Microsoft moving Power BI visual offers to Commercial 	
	 	 Marketplace within Partner Center (sic)

Visualisations

	 •	 PAFnow Process Mining flowchart visual by Process Analytics 	
	 	 Factory GMBH
	 •	 Drill Down Network PRO by ZoomCharts
	 •	 Annotated Bar by Queryon
	 •	 Graphomate pictograms 2021.2 by Graphomate
	 •	 New visuals in AppSource

Paginated Reports

	 •	 New version of Power BI Report Builder.

Let’s go through each in turn.

New formatting options for buttons

Buttons in Power BI have now been updated to include a lot more formatting options, including new shapes and custom icons.

Previously, buttons were only available in the rectangular form.  Now with this release, you have a lot more shapes to choose from:

While ‘Rectangle’ is still the default shape for buttons, you can change to shape by navigating to the Shape tab of the Format button pane, viz.

	 •	 Arrow
	 •	 Chevron Arrow
	 •	 Pentagon Arrow
	 •	 Heart
	 •	 Hexagon

	 •	 Isosceles Triangle
	 •	 Octagon
	 •	 Oval
	 •	 Parallelogram
	 •	 Pentagon

	 •	 Pill
	 •	 Rectangle
	 •	 Right Triangle
	 •	 Rounded Rectangle
	 •	 Speech bubble

	 •	 Tab: Single Corner Rounded
	 •	 Tab: Single Corner Snipped
	 •	 Tab: Top Corners Rounded
	 •	 Tab: Top Corners Snipped
	 •	 Trapezoid.
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In addition to new shapes available for buttons, this release also includes new formatting options such as:

	 •	 Custom image or icon for your button

You can find this option by navigating to the Icon tab of the Format button pane and selecting the Custom option for Icon:

Once you add your image you can also customise the Image fit:

	 •	 Easy icon placement options
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You can find these options in the Icon placement dropdown of the Icon tab:

If you select the Custom option, you can control icon’s vertical and horizontal alignment:

	 •	 Control Icon margin (alternatively known as padding)

	 •	 Customise and fix the Icon size
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By default the Icon size is set to Auto, meaning that as you resize the button, the icon size will automatically change in size.

However, now you have the option to set a fixed Icon size (in pixels):

	 •	 Drop Shadow effects

	 •	 Glow effects

	 •	 Button Shape rotation and Text rotation

Toggle total columns in waterfall charts

You may now turn off total columns in your waterfall charts.  You will find 
this new toggle in the y-axis card in the formatting pane.  If you turn it 
on, the totals of your waterfall charts will be removed (which seems the 

wrong way round to my little brain).  Note that if you have a breakdown 
field, your visual will have subtotal columns but not a total column, so 
you will not see this option in the Formatting pane. 
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Line chart series labels

Sensitivity label support for Power BI template files

Insights (Preview)

This month also sees a new option to create and format series labels in 
your line charts.  Using the series labels option in the Formatting pane, 
you can turn on and format labels that appear on the left or right sides 

of your series categories in line charts.  These supplement the legend 
in providing clarity on which lines are associated with which categories. 

In Power BI Desktop, you can create and use templates to create new 
reports.  MIP sensitivity labels enable you to properly classify Power BI 
files.  Now, you can also apply a MIP label to Power BI template files 
(.pbit).  Upon export to Power BI template, a MIP label and protection 

set on a Power BI file (.pbix) will be applied on the new template file.  
When a new report is created from the template file, the label will be 
applied too.

The Insights feature helps users easily find and explore insights such 
as anomalies, trends and KPI analysis in their data, as they interact 
with and consume their reports.  It proactively notifies a user if there 
are interesting insights in their reports and provides explanations for 
the insights.  It works out of the box on any report so consumers can 

automatically get insights without any setup or configuration by the 
creators.  Insights is supported for reports in Premium and Premium Per 
User (PPU) workspaces.  You can also use this capability in non-premium 
workspaces if you have a PPU license.
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When you open a report, Power BI automatically runs insights analysis 
and shows you notifications if there are Top insights in your data.  Top 
insights are those that are noteworthy based u[on factors like recency 

and significance, e.g. a huge anomaly in the previous day or a steep trend 
in the last week.

Clicking on ‘See Insights’ on this dialog (Microsoft refers to it as a ‘toast’), opens up the Insights pane:

You can also click on ‘Get insights’ in the Action bar at any time to see Insights about the current report page.

Selecting ‘More options’ (…) in the upper-right corner of a visual and then ‘Get insights’ shows you insights about just that visual:
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The Insights pane currently shows you three types of insights:

	 1.	 Anomalies
	 2.	 Trends
	 3.	 KPI analysis.

Clicking on the card shows you more details about the insight and possible explanations:

Shortcut expression for CALCULATE now supports aggregation functions

New parameter for XIRR function

Making it easier to format based on a user’s locale

Power BI has now made it easier to write filters for the CALCULATE and 
CALCULATETABLE functions.  You may now use aggregation functions in 
the filters when they are used in Boolean (True / False) expressions.  You 

should note that the newly supported syntax improve the readability of 
the DAX expressions but don’t impact performance when compared to 
their more verbose equivalent expressions. 

In certain situations, the XIRR function (a financial function that can be 
used to calculate the internal rate of return, i.e. the discount rate that 
will make the present value of the given free cash flow zero) is unable to 
find a solution and returns an error.  Starting with this release, Microsoft 

has added a fifth and optional parameter that enables you to specify an 
alternate result which will be returned instead of an error whenever the 
XIRR function cannot find a solution.

The FORMAT function enables you to convert a value to text according to a specified format.  This month sees Power BI add the ability to specify a 
locale.  For example, if you wanted to show a date in the English / Great Britain locale you could write:

FORMAT( dt”2010-12-03T12:30:59”, “General date”, “en-GB” )

This returns 03/12/2010 12:30:59, where the day precedes the month, and the time is written in 24-hour format.

If you wanted to show a date in the English / United States locale instead you could write:

FORMAT( dt"2010-12-03T12:30:59", BLANK(), "en-US" )

As an example of the newly supported syntax:

CALCULATE([Total Sales], DimProduct[UnitPrice] > MEDIAN(DimProduct[UnitPrice]))
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This returns 12/3/2010 12:30:59 PM, where the month precedes the day, and the time is written in 12-hour format.  You should note that this second 
example does not specify a format string altogether.

If you specify a format string that is not locale-dependent such as “mm/dd/yyyy” that format string will be used, and any locale specified will not be 
used.  Hence, the following will return 12/3/2010 even though “en-GB” is specified as the locale:

FORMAT( dt"2010-12-03T12:30:59", "mm/dd/yyyy", "en-GB" )

As another example, consider the following:

FORMAT( 123456.78, "###,###.##", "nl-NL")

This returns 123.456,78 as in the Netherlands (nl-NL locale) the comma is used as the decimal separator and the thousand separator is a dot, whereas 
switching the locale to “en-US” returns 123,456.78, i.e. it’s the other way around.

You should note that these examples leverage the new way of expressing datetime values in DAX introduced last month.  Of course, you can pass in 
a column reference or use the date functions to provide the date and time.

Power BI Connector in Power Automate is now Generally Available

AssembleViews now Generally Available

Azure Databricks (connector update)

Bloomberg Enterprise Data and Analytics now Generally Available

DataVirtuality (connector update)

Vena now Generally Available

Power BI Goals: automated status rules (Preview)

Exasol (connector update)

The Power BI Connector in Power Automate is now Generally Available.  
This connector allows Power BI users to use Power Automate to perform 
actions within Power BI, including refreshing a dataset, performing 

exports on Power BI reports or performing an action when a data driven 
alert is fired.  Microsoft has commented that they will be developing 
additional actions for this connector soon.

This connector is now Generally Available.

This update adds support for export and import of PBIDS files.

This connector has now been made Generally Available.  According to the Bloomberg team, “…this connector is no longer considered in ‘Beta’.  In 
addition, [their] recent update changed the entry field from a single-line to a multiple-line entry so users can see their full BQL query”.

This connector update adds a mapping for string data type with large size to allow usage of that data type in Direct Query Report Visuals.  It further 
improves comfort for handling of unencrypted connections in create connection process.

This connector is now Generally Available and has made error handling improvements.

One of the important attributes of a goal defined within Power BI scorecards is its status.  With this new release, scorecard authors will be able to 
automate status updates based on rules that govern that goal or subgoal.

This update contains the following changes:

	 •	 DSN support
	 •	 limited Kerberos authentication support
	 •	 implicit authentication is now also possible.
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Users will be able to precisely set when goals are on track or falling behind.  Scorecard authors will be able to set up rules that automate statuses 
based upon the value, percentage of target met, date conditions or a combination of the three.

Once those rules are set, you can assign the priority by simply dragging them into place.

Power BI Goals: improved filtering (Preview)

With this new release, we have incorporated improved filtering capabilities.  Now, you can easily view all the goals labelled as a particular status by 
clicking on the summary cards, making it easier than ever to see at a glance what’s at risk and what’s on track.
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This update also includes a keyword search, making it easier to search for specific goals and see how they’re doing at a glance, without losing context 
of the parent / child relationships.

APIs to determine who has access to what Power BI artifacts (Preview)

Microsoft has a new set of APIs that allow you to programmatically 
retrieve user and permission information for most Power BI assets 
(reports, dashboards, datasets, dataflows, workspaces and capacities).  

They can help Power BI administrators support access review audits, 
understand oversharing risks and see who has access to Power BI assets.  
For this Public Preview, this update releases two types of APIs:
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	 1.	 The first one requires you to supply an asset identifier and will 	
	 	 output the users and groups that have been granted access to 	
	 	 the asset

	 2.	 The second one is an extension to the Scanner Admin API to that 	
	 	 adds users or security groups with their access levels for one or 	
	 	 more workspaces.	

When you need to spot check access rights for a particular asset, such as 
a report, a dashboard or dataset, to assess potential data leakage risk, 
you want to leverage the Who has Access to an Asset API, such as the 
GetReportUsersAsAdmin API.  When your information security team asks 
you perform an access review audit across the entire tenant or multiple 
workspaces, the scanner API with user permission extension will come in 
handy.  It provides you with user access information for various Power BI 
assets across all your workspaces.

Service Principal support for read-only Admin APIs now Generally Available

Goals now available in Power BI Mobile apps

To better support the security constraints of some organisations, this 
update has added service principal support for the scanner Admin APIs.  
Service principal is an authentication method that can be used to let an 
Azure AD application access Power BI APIs.  This gets rid of the need to 
maintain a service account with an administrator role.  To allow your 
application to use the Admin APIs, you only need to give your approval 

once as part of the tenant settings configuration.  This was made a Public 
Preview feature last December and has now become Generally Available.  
There is a  difference: the Generally Available version has added support 
for new administrator APIs to determine who has access to what Power 
BI artifacts.

Now while you’re on the go, you can monitor your goals and scorecards 
and even check in progress, directly from the mobile app.  This is because 
a new Goals hub has been added to the app, making it possible for you 

to view your scorecards and closely monitor your assigned goals.  With 
the mobile app’s new Goals hub, you can stay on top of your targets from 
anywhere at any time.

To keep your goals up to date, you can update values using either ‘Quick check-in’ or ‘New check-in’.
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Explore content that’s relevant to you (Android and iOS)

Now you can request access to reports from your mobile app

Microsoft moving Power BI visual offers to Commercial Marketplace within Partner Center

Furthermore, you may now enhance your Power BI mobile experience 
and productivity by exploring content from your organisation that has 

been picked especially for you.  It’s there for you on the Home page in 
the new Recommended strip or on the new Explore page.

If ever someone has sent you a link to a report, but it’s not shared with you, and you find you don’t have access, you can now request access directly 
from the application.  About time too!

If you have one or more Power BI visual offers, either published or as a 
draft, then you need to be aware of this move.  Microsoft has decided 
to move in order to streamline the offer management experience.  
Apparently, multiple improvements are coming with this migration and 
“…many more are to come in future”.

This will be happening shortly.  During the migration, your customers will 
still be able to find and acquire your offers.  You can continue accessing 
your offers in Office Store until the move.  Then, you will be required 
to enrol into the Commercial Marketplace (CMP) to continue managing 
your Power BI visual offers in Partner Center.  When the offer migration 
is complete, your Power BI visual offers will not be accessible in Office 
Store and can only be accessed from CMP for those who are enrolled.

Therefore, if this applies to you, you should complete the enrolment 
to CMP as soon as possible.  Additionally, you may follow the in-portal 
instructions in Office Store within Microsoft Partner Center (microsoft.
com) to complete the enrolment.

With this migration, publishers must submit their files (PBIX and PBIVIZ) 
directly to Partner Center.  You don’t need to email the support team 
to get the XML.  This should be a significant benefit that simplifies the 
submission process.

With the new process, you may use the “compare” feature to see 
changes from previously submitted versions before publishing your 
offer, enhanced informative messages to provide you with more details 
on the visual submission status, and an enhanced review and publish 
page to provide more details about the offer setup.
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PAFnow Process Mining flowchart visual by Process Analytics Factory GMBH

Drill Down Network PRO by ZoomCharts

PAFnow Process Mining Visual is a powerful tool for the analysis of your business processes based upon event data.  You may use this visual to 
explore process variants, identify bottlenecks, reveal root causes, etc.

With PAFnow, you can obtain a facts-based, data-driven process visualisation that will allow you to realize the following business benefits:

	 •	 reduce operational costs
	 •	 improve operating margin
	 •	 improve efficiency
	 •	 accelerate automation with RPA.

There are some newly added features too:

	 •	 Filter preview to see how filters will change the visual
	 •	 Breadcrumbs for filter history to discard and add filters easily
	 •	 more flexibility in display options of edge and node labels and ToolTip.

You can test the new PAFnow Process Mining visual to accelerate your projects.  The in-app purchase of this visual, enables an upgrade to PAFnow 
Enterprise for advanced analysis features, additional visuals and unlimited events.  There are no purchases required to use the visual itself.

You can check this visual out on AppSource.
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Drill Down Network PRO by ZoomCharts is a new visual that may be used to explore networks of category-based data.  This visual allows you to 
transform your multi-level pie chart into a network chart that allows you to view relations and spot outliers.  

Among the main features of Drill Down Network PRO you will find:

	 •	 full customisation: you may choose from multiple node shapes, customise vertices, edges, etc.
	 •	 cross-chart filtering: instead of using slicers, you may select data points on multiple charts
	 •	 image support: modify your reports with images to emphasise vertices
	 •	 drill through support: examine data in more detail when selecting the last drill through level
	 •	 multi-touch device friendly: experience consistent data exploration on any device.

You can download a free 30-day trial of Drill Down Network PRO from the AppSource.

Annotated Bar by Queryon

Graphomate pictograms 2021.2 by Graphomate

This custom visual combines bar chart functionality with customisable 
labels so that your users will focus on key data in a bar chart.  Users may 
customise your label colour, font, size and position of the bar, and can 
drill down by clicking on labels or the bar itself.

Multiple Bar styles like Stacked, Side-by-Side (Clustered), and Overlapping 
(also known as “Bar in a Bar”) are available.  Overlapping bars help display 
the comparison between two items when one is inherently a part of the 
other, such as a project budget versus expenditures to date.

It’s well known that it’s easier for viewers to recall certain data if it is shown as a pictogram or icon.  With this visualisation, you may select icons 
from an existing palette or insert your own symbols (e.g. product icons) as you like.  The Graphomate pictograms allow the scaling of a single icon 
as a fixed unit.

Advantages of using Graphomate pictograms include:

	 •	 freely selectable icons per data series and data point
	 •	 horizontal or vertical alignment
	 •	 alternatives are possible from a central axis, from where a data series may begin to the left or to the right
	 •	 any image (jpeg, gif, png, svg) may be used
	 •	 DataURL is supported.

You can make use of the integration of Graphomate’s custom visuals and use filters and slicers side by side with the standard visuals.

As usual, it may be downloaded from the AppSource.
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New visuals in AppSource

New version of Power BI Report Builder

Other new visuals not mentioned above include:

	 •	 Laconic Card PRO
	 •	 Lipstick Bar Chart
	 •	 process.science Process Mining
	 •	 SPC G Chart
	 •	 SPC U ‘Prime’ Chart
	 •	 Sunburst by MAQ Software
	 •	 Timeline Box
	 •	 TRUECHART for Power BI
	 •	 valQ – Collaborate.

A new version of Power BI Report Builder is also available now.  With this 
update of Power BI Report Builder, the 64-bit version is now available 
from the Microsoft Download Center, in addition to the Microsoft Store, 
for enhanced memory limits and other performance gains.  Enhanced 

support for Date/Time parameters is now provided.  This update also 
includes a number of accessibility fixes related to keyboard shortcuts 
and screen reading tools.  You should note that previously installed third-
party data providers may need to be updated to their 64-bit versions.

More next month, we’re sure!

The A to Z of Excel Functions: GESTEP

It may sound like some sort of military walk, but the GESTEP function was 
used to assist filtering out data.  Imagine you wanted to identify data that 
exceeded or was equal to some hurdle (target value).  If you are familiar 
with the IF function, you might create a calculation such as

=IF(value >= hurdle, 1, 0)

In this case, if the variable value is greater than or equal to the hurdle, 
then a value of one (1) is returned, else zero (0).  Well, guess what?  There 
is a seemingly pointless Excel function out there that already does this for 
you.  As a model auditor for more than 30 years, I can honestly say I have 
never seen the following function used in practice!

However, for completeness, the Excel function GESTEP returns one (1) if a 
compared number is greater than or equal to a “step” (the given hurdle), 
otherwise it returns zero (0).  This function may be used to filter a set 
of values.  For example, by summing several GESTEP functions you can 
calculate the count of values that exceed a threshold.  

GESTEP has the following syntax:

GESTEP(number, [step])

The GESTEP function has the following arguments:

	 •	 number: this is required, and represents the value to test against  
		  the hurdle, step
	 •	 step: this argument is optional.  This is the threshold value; if this 	
		  value is omitted, it is assumed to be zero (0).

It should be further noted that:

	 •	 if any argument is nonnumeric, GESTEP returns the #VALUE! error 	
		  value.

Please see our example below: 
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The A to Z of Excel Functions: GETPIVOTDATA
To understand the GETPIVOTDATA function, we first need to understand PivotTables.

Many analysts use Excel to summarise cleaned-up data and convert it into information, with structured (sorted and / or ordered) referencing, so that 
users may understand their numbers, identify trends and produce various reports.

To understand what I mean, as an example, we may receive data like this:

Each attribute (known as a field) in a table typically contains a category of 
data.  A crosstab query (similar to the one pictured, above) summarizes the 
data from one or more of these fields that are separated into groups based 
on one or more fields.  Essentially, a crosstab query summarizes data in 
more than one dimension to provide insight that may not be immediately 
forthcoming otherwise. For example, given the source data, how could you 
possibly notice that Sales for Quarter 4 in the South are very low relative to 
other quarters and regions?

Excel has many useful tools that will assist, centred around its version of an 
enhanced crosstab query, known as a PivotTable. 

Crosstabs let you quickly compare, contrast and otherwise assess sales 
activity based on the variables you chose.  However, if you sought to 
deeply analyse the data, you would need to re-design your crosstab query.  
No such limitation exists with PivotTables.

PivotTables allow you to analyse in two dimensions (row and column), and 
filter on many parameters.  They let you filter, drag, drop, rearrange and 
drill down on data to create additional reports right on the spot. 

and we may turn it into something more informative, such as this:
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Due to their similar appearance, crosstabs and PivotTables are often 
referred to as the same thing. They are not. While they do have obvious 
differences, both can be powerful tools for providing deeper insights into 
your existing data. Here, we will concentrate on PivotTables.

A PivotTable is a semi-dynamic, tabular summary of data.  It is one of 
Excel’s most flexible tools and can provide results that would take some 
time to reconstruct with sophisticated uses of functions such as SUMIF, 
SUMPRODUCT, and so on.

Imagine we are a Head Office Analyst reviewing the sales of four divisions: 
imaginatively called North, South, East, and West. For reasons known only 
to me, that’s the order I wish to report – neither alphabetically nor reverse 
alphabetically.

Creating a PivotTable is straightforward.  Assuming the dataset is in one 
block (a ‘contiguous’ range) and has been converted to a Table (Ctrl + T) 
so that the range may be extended automatically, simply select any cell 
within the dataset and then click on Insert -> PivotTable (Alt + N + V [+ T]):

This gives rise to the ‘Create PivotTable’ dialog box:

You have the choice of where to place the PivotTable report – either on an 
existing worksheet (not necessarily the worksheet you are on presently) or 
else insert a new worksheet.

I have a “rule of thumb” regarding PivotTables.  If you are using them for 
analysis and the fields may be switched to assess trends / understand the 
data, then the PivotTable may vary in size considerably.  Therefore, it is 
best to have the PivotTable on a separate worksheet, with very little else 
on it, so that it cannot clash with other spreadsheet elements, such as 
charts, datasets, formulas, and so on. 

However, if the PivotTable is more “mature” and is being used to summarise 
data on an output sheet, then you may put more than one PivotTable on 
the sheet, as long as you ensure they cannot collide when changing filters.  
These sheets tend to be output sheets known as dashboards.  It’s a good 
idea to place PivotTables at the foot of any such sheet so that if a filter 
reduces the PivotTable’s footprint significantly, the white space created 
will not look conspicuous.
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Also, remember when selecting where to place a PivotTable, always remember the main PivotTable will be positioned two rows further down.  Do 
remember if you make a mistake, it’s not the end of the world! You have two options available to you:

	 1.	 Move the PivotTable: This is very easy to do. Simply click a cell within the PivotTable. This triggers the context specific ‘PivotTable Tools’ tabs 	
		  ‘Analyze’ and ‘Design’. On the ‘Analyze’ tab, in the ‘Actions’ grouping, select ‘Move PivotTable’ (Alt + JT + V) and then follow the instructions

	 2.	 Delete the PivotTable: This is even easier to achieve! Simply highlight the entire PivotTable range and select ‘Delete’ on the keyboard.

The PivotTable has four areas where data fields may be placed (a data field is simply any one of the columns of the database, for example, Date, 
Division, Sales Person, Amount Invoiced, in this illustration):

	 •	 Page: Values in this field appear as page items in the PivotTable

	 •	 Row: Values in this field appear as row items in the PivotTable

	 •	 Column: Values in this field appear as column items in the PivotTable

	 •	 Data: The field to be summarized – if this data is numerical in nature, SUM (how much) will be the default operation, otherwise COUNT (how 	
	 	 many) is used. They are easily changed, if necessary.

More than one field can be placed in any of these locations – the effect is 
a hierarchical grouping depending upon the order of placement.

In essence, a PivotTable is a three-dimensional summary of a database.  
Consider it as a book: each page has a summary table of a selection of 
the data (for instance, in our example, each page could show the sales of 
each electrical item for each region and division on a particular date, so 
Page 1 is 1 1 Jan 20, Page 2 is 2 Jan 20, and so on).

To populate the layout, it is simply a case of dragging and dropping, 
provided you have the PivotTable Fields pane visible (previously known 
as the Field List). If it does not appear, right-click anywhere in the 
PivotTable region and on the shortcut menu select the last item ‘Show 
Field List’.  The PivotTable Fields pane appears when you click inside the 
PivotTable region:
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The PivotTable Fields pane will look similar to this (it can be resized if necessary):

The fields may be dragged into the bottom section, dragging it into one of the four windows below (‘Filter’ is the ‘Page’ equivalent).  If I just dragged 
‘Region’ in for instance (into ‘Rows’) I would get a sorted, unique list of the regions:
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That’s fine, although with the dynamic array functions SORT and UNIQUE now available in some versions of Excel (with no need to refresh data as it 
changes), this may not be as useful a trick as it once was.

As a more comprehensive example, let’s consider I had dragged fields around as follows:

Depending upon your current PivotTable settings, your PivotTable might look something like the following:

How easy is this? I feel like I am writing under false pretences.  The number formatting could be better, the three text fields “Sum of Amount 
Invoiced”, “Column Labels” and “Row Labels” look a little clunky, but it’s not a bad start.  

One great thing about PivotTables is how easy they are to manipulate.  Subtotals may be added from the Design tab:
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It’s important to realise that your data may move as you modify your PivotTable.  Imagine you wished to link a formula to Brandy’s sales in Eregg 
(circled).  Here, the cell reference would be D16.  However, after filtering on Date, Division and Sales Person, the PivotTable is restated as

Not only is the value different (due to the Date filter), now the cell reference is C11.  The Excel formula would not move because no rows / columns 
have been inserted / removed.  This is where the function GETPIVOTDATA comes in.

Check File -> Options and then go to Formulas:
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If ‘Use GetPivotData functions for PivotTable references’ is checked, 
then clicking on the cell containing Brandy’s sales for Eregg would not 
have provided a typical Excel reference. Instead, it would generate the 
formula

=GETPIVOTDATA("Amount Invoiced",$A$3,"Division","East","Region",
"Eregg","Sales Person","Brandy")

This should be read as “for the PivotTable with ‘Amount Invoiced’ in its 
top left-hand corner in cell A3, report back the sales where the Division is 
East, the Region is Eregg and the Sales Person is Brandy – it’s essentially 
the PivotTable equivalent of the SUMIFS function.

On a side note, you should also see that our trick from earlier – putting 
‘Amount Invoiced ‘ (with a trailing space) has fooled GETPIVOTDATA.

Using GETPIVOTDATA allows you to reference data in the PivotTable as 
long as it is in the PivotTable!

You can use GETPIVOTDATA to retrieve summary data from a PivotTable, 
provided the summary data is visible in the report.

Note: You can quickly enter a simple GETPIVOTDATA formula by typing 
= (the equal sign) in the cell you want to return the value to and then 
clicking the cell in the PivotTable that contains the data you want to 
return.

Its syntax is as follows:

GETPIVOTDATA(data_field, PivotTable, [field1, item1, field2, item2], ...)

It has the following arguments:

	 •	 data_field: this is required and represents the name, enclosed in  
		  quotation marks, for the data field that contains the data that  
		  you want to retrieve
	 •	 PivotTable: this is also required.  This is a reference to any cell,  
		  range of cells, or named range of cells in a PivotTable.  This  
		  information is used to determine which PivotTable contains the  
		  data that you want to retrieve 

	 •	 field1, item1, field2, item2: these pairs of arguments are 	  
		  optional. If used, you may have from 1 to 126 pairs of field names 	
		  and item names that describe the data that you want to retrieve.   
		  The pairs may be in any order.  Field names and names for items  
		  other than dates and numbers are enclosed in quotation marks.   
		  For OLAP PivotTables, items can contain the source name of the  
		  dimension and also the source name of the item.  A field and  
		  item pair for an OLAP PivotTable might look like this:
		  "[Product]","[Product].[All Products].[Foods].[Baked Goods]".

It should further be noted that:
	 •	 calculated fields or items and custom calculations are included in 	
		  GETPIVOTDATA calculations
	 •	 if PivotTable is a range that includes two or more PivotTables, 		
		  data will be retrieved from whichever report was created most 	
		  recently in the range
	 •	 if the field and item arguments describe a single cell, the value of  
		  that cell is returned regardless of whether it is a string, number,  
		  error, and so on
	 •	 if an item contains a date, the value must be expressed as a serial  
		  number or populated by using the DATE function so that the  
		  value will be retained if the worksheet is opened in a different  
		  locale.  For example, an item referring to the date March 5, 1999  
		  could be entered as 36224 or DATE(1999,3,5)
	 •	 times may be entered as decimal values or by using the TIME 		
		  function.
	 •	 if PivotTable is not a range in which a PivotTable is found,  
		  GETPIVOTDATA returns an #REF! error
	 •	 if the arguments do not describe a visible field, or if they include  
		  a report filter in which the filtered data is not displayed, 		
		  GETPIVOTDATA returns the #REF! error value.

Please see our example below: 
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The A to Z of Excel Functions: GROWTH

A window function (also known as an apodization or tapering function) is 
a mathematical function that has a zero value outside of a chosen interval.  
Uniform distributions and the bell curve are two such window functions 
commonly used in statistics.

Exponential smoothing is what’s known as a rule of thumb technique (i.e. 
not strictly accurate) for smoothing time series data using the exponential 
window function.  The aim is to smooth out historical data to predict 
trends, etc.

The aim is to develop a technique to identify what would be next in a 
series, i.e. forecast the future.  There are various approaches used:

	 •	 Naïve method: this really does live up to its billing – you simply use 	
		  the last number in the sequence, e.g. the continuation of the series 	
		  8, 17, 13, 15, 19, 14, … would be 14, 14, 14, 14, …  Hmm, great

	 •	 Simple average: only a slightly better idea: here, you use the 		
		  average of the historical series, e.g. for the continuation of the 		
		  series 8, 17, 13, 15, 19, 14, … would be 14.3, 14.3, 14.3, 14.3, …  

	 •	 Moving average: now we start to look at smoothing out the trends  
		  by taking the average of the last n items.  For example, if n were 3,  
		  then the sequence continuation of 8, 17, 13, 15, 19, 14, … would be  
		  16, 16.3, 15.4, 15.9, 15.9, …

	 •	 Weighted moving average: the criticism of the moving average is  
		  that older periods carry as much weighting as more recent periods,  
		  which is often not the case.  Therefore, a weighted moving average  
		  is a moving average where within the sliding window values are  
		  given different weights, typically so that more recent points matter  
		  more.  For example, instead of selecting a window size, it requires  
		  a list of weights (which should add up to 1).  As an illustration, if we  
		  picked four periods and [0.1, 0.2, 0.3, 0.4] as weights, we would  
		  be giving 10%, 20%, 30% and 40% to the last 4 points respectively  
		  which would add up to 1 (which is what it would need to do to  
		  compute the average).

		  Therefore the continuation of the series 8, 17, 13, 15, 19, 14, …  
		  would be 15.6, 15.7, 15.7, 15.5, 15.6, …

These only go so far.  Sometimes, you want to spot non-linear, trends, e.g. 
sales are based on an exponential growth curve.  The GROWTH function 
calculates the predicted exponential growth by using existing data.  It 
returns the y-values (dependent values) for a series of new x-values 
(independent values) that you specify by using existing x-values and 
y-values.  Therefore, you may use the GROWTH worksheet function to fit 
an exponential curve to existing x-values and y-values too.
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The GROWTH function employs the following syntax to operate:

GROWTH(known_y's, [known_x's], [new_x's], [constant])

The GROWTH function has the following arguments:
	 •	 known_y's: this is required and represents the set of y-values you already know in the relationship y = b*m^x
		  o	 if the array known_y's is in a single column, then each column of known_x's is interpreted as a separate variable
		  o	 if the array known_y's is in a single row, then each row of known_x's is interpreted as a separate variable
		  o	 if any of the numbers in known_y's is zero or negative, GROWTH returns the #NUM! error value
	 •	 known_x's: this argument is optional and denotes an optional set of x-values that you may already know in the relationship y = b*m^x
		  o	 the array known_x's can include one or more sets of variables.  If only one variable is used, known_y's and known_x's can be ranges of any  
			   shape, as long as they have equal dimensions.  If more than one variable is used, known_y's must be a vector (that is, a range with a height of  
			   one row or a width of one column)
		  o	 if known_x's is omitted, it is assumed to be the array {1,2,3,...} that is the same size as known_y's
	 •	 new_x's: this is optional.  These are new x-values for which you want GROWTH to return corresponding y-values
		  o	 new_x's must include a column (or row) for each independent variable, just as known_x's does.  Therefore, if known_y's is in a single column,  
			   known_x's and new_x's must have the same number of columns.  If known_y's is in a single row, known_x's and new_x's must have the same  
			   number of rows
		  o	 if new_x's is omitted, it is assumed to be the same as known_x's
		  o	 if both known_x's and new_x's are omitted, they are assumed to be the array {1,2,3,...} that is the same size as known_y's
	 •	 constant: this is also optional.  This represents a logical value specifying whether to force the constant b to equal 1
		  o	 if constant is TRUE or omitted, b is calculated normally
		  o	 if constant is FALSE, b is set equal to 1 and the m-values are adjusted so that y = m^x.

Further, it should be noted:
	 •	 formulae that return arrays must be entered as array formulae after selecting the correct number of cells
	 •	 when entering an array constant for an argument such as known_x's, use commas to separate values in the same row and semicolons to separate  
		  rows.

Please see my example below: 

More Excel Functions next month.

Beat the Boredom Suggested Solution
This month, we looked at a common “clean up” problem in Excel – how to 
separate text and numbers.

As we stated earlier, often, we receive data that isn’t in the best of shape.  
It may have text and numbers intermingled and you wish to separate 
(i.e. space) them out.  For example, you might want “Pelham123” to be 
“Pelham 123”, or require “121Training” to be “121 Training”.  

Where there is just the one change of data type in the text string, it’s 

possible to create a reasonably straightforward formula, but things get 
harder with multiple occurrences.  And that’s what this month’s challenge 
was – fix the issue in general.

This month’s challenge was to construct an Excel formula that will split 
out multiple occurrences of numbers and text without using third party 
add-ins, VBA (e.g. User Defined Functions) and Power Query solutions, e.g.

mailto:contact@sumproduct.com
http://www.sumproduct.com


contact@sumproduct.com  | www.sumproduct.com  | +61 3 9020 2071 

Suggested Solution

This problem has been a regular challenge for Excel users since the dawn of time.  Well, 1985 anyway.  Dynamic arrays have made the task easier 
because you can now undertake repetitive checks.  Dynamic arrays have made the task easier because you can now undertake repetitive checks.  
Dynamic arrays have made the task easier because you can now undertake repetitive checks…

OK, the joke’s over.  The joke’s over.  The joke’s over…

As you can see, our suggested solution is extremely simple:

=F12

If you need help with this calculation, then the rest of this explanation is not looking good.  This simply links the original input into cell P28, so all the 
formulae are close together.  That’s not so exciting.

The next formula is a tad more interesting:

=MID(P28,SEQUENCE(1,LEN(P28)),1)

Even in this stepped out approach, I have managed to include three functions in one formula!

	 1.	 LEN(P28) is a text function that counts the number of characters (its “volume”) in the text string in cell P28.  In the example (above), there 	
		  are 58 characters, so LEN(P28) equals 58

	 2.	 The SEQUENCE(rows, [columns], [start], [step]) function has one required (rows) and three optional arguments.  This is one of the new 	
		  dynamic array functions and fills rows number of rows, columns number of columns (1 if not specified), starting at start (1 if not specified) 	
		  in increments of step (1 if not specified).  Hence, =SEQUENCE(4,3,2,1) would be

=PROPER(TRIM(CONCAT(IF(INDEX(IF(ISNUMBER(VALUE(MID(F12,SEQUENCE(1,LEN(F12)),1))),1,),SEQUENCE(1,LEN(F12)))=INDEX(IF(ISNUMBE
R(VALUE(MID(F12,SEQUENCE(1,LEN(F12)),1))),1,),SEQUENCE(1,LEN(F12),0)),MID(F12,SEQUENCE(1,LEN(F12)),1),""&MID(F12,SEQUENCE(1,LEN
(F12)),1)))))

Any questions?

Perhaps we need to step through this monster.

Let’s step through the mechanics of this calculation by breaking it down component by component.  The first element is (hopefully) straightforward!

mailto:contact@sumproduct.com
http://www.sumproduct.com
https://www.sumproduct.com/thought/getting-arrays-spilling-the-beans-on-seven-new-functions
https://www.sumproduct.com/thought/getting-arrays-spilling-the-beans-on-seven-new-functions


contact@sumproduct.com  | www.sumproduct.com  | +61 3 9020 2071 

	 It would consist of 12 cells (4 rows by 3 columns), starting with the number 2 and increasing in increments of 1 (as pictured).

	 Therefore, =SEQUENCE(1,LEN(P28)) would be the numbers 1 to 58, all in one row, across 58 columns

3.	 Finally, =MID(P28,SEQUENCE(1,LEN(P28)),1) uses the MID(text, start_number, length) function.  Here, it takes a sub-text string from the 	
	 text reference, starting at position start_number of length.  So, =MID(“abcdefg”,2,3) would be “bcd” being three characters starting from the 	
	 second position.

	 Therefore, =MID(P28,SEQUENCE(1,LEN(P28)),1) simply splits the text string out into 58 cells across a row, each cell consisting of just one of the 	
	 58 characters in the text string.  It should be noted that MID converts every element to a text string, i.e. all characters are text – even numbers.

You can read more about the text functions LEN and MID here.

Let’s look at the next two formulae together:

=VALUE(P30#)

=IF(ISNUMBER(P32#),1,)

I want to identify which characters are numbers in the range starting in cell P30 (P30# simply means the spilled dynamic array, so all 58 cells – but 
this will change if the text length changes).  ISNUMBER will do this – but not straight away.  Remember, MID has converted everything to text, so 
first I need to convert numbers back to numbers.

Interestingly, the N function won’t work here (it will “coerce” the range back to one cell), but VALUE will.  Values of text characters are #VALUE! by 
definition.

Then, with this new range in P32#, we can see what is a number and what isn’t.  The formula 

=IF(ISNUMBER(P32#),1,)

Simply provides a 1 for every numerical value and zero (0) for everything else (including #VALUE! errors).

The next three steps may be considered together:

=INDEX(P34#,SEQUENCE(1,LEN(P28)))

=INDEX(P34#,SEQUENCE(1,LEN(P28),0))

=P36#=P38#

The expression =SEQUENCE(1,LEN(P28)) has already been explained: this generates the numbers 1 to 58 in 58 cells across the row.  Since P34# 
contains 58 cells across one row, 

=INDEX(P34#,SEQUENCE(1,LEN(P28)))

is a seemingly rather longwinded way of replicating P34# - the first cell provides the first value in the vector P34#, the second cell provides the 
second value in the vector P34# and so on.  It seems convoluted.  It’s subtle though: this formula is giving us a way of referencing a particular 
position in the range P34#.  That’s important when we consider the second formula:

=INDEX(P34#,SEQUENCE(1,LEN(P28),0))
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Almost the same formula, the start of zero (0) is specified in the SEQUENCE function.  When it is not specified (as in the first formula considered in 
this section), it is assumed to start at one (1).  This has the effect of producing the same result as the first formula, albeit displaced one cell to the 
right, e.g. the first cell provides the “noughth” value in the vector P34#, the second cell provides the first value in the vector P34#, and so on.  In other 
words, it displays the previous cell result.

The formula

=P36#=P38#

simply checks that the current cell and the previous cell in the range are both text or both numerical values (TRUE).  If they differ, the result is FALSE.  
This is what we want to find.  Wherever we have a FALSE value, we need to add a space to separate text and numbers (or vice versa).  This is precisely 
what the next formula does:

=IF(INDEX(P34#,SEQUENCE(1,LEN(P28)))=INDEX(P34#,SEQUENCE(1,LEN(P28),0)),P30#," "&P30#)

This formula takes the logic of the above.  The formula =P36#=P38# cannot be referred to per se (it has been provided for illustration) as this is not 
how dynamic arrays work.  However, this formula checks for inconsistent data types between the cell and the prior and adds a preceding space if 
the two data types differ (i.e. the equality is FALSE).  For example, the value in cell T42 is not 1, but “ 1” (i.e. it has a preceding space to delineate 
between text and number).

The final three formulae simply tidy things up:

=CONCAT(P42#)

=TRIM(P44)

=PROPER(P46)

The formula in cell P44 simply combines all the cell values back into one cell using the CONCAT (concatenate) function; the formula on cell P46 
removes excess spaces using TRIM; the final formula in cell P48 just puts all text into “Proper” case, i.e. each word starts with a capital letter, with 
all other letters using lower case.

That’s it.

To get the monster formula, you just build each formula into its dependent calculation so the last formula could be expressed as

=PROPER(TRIM(P44))

and the formula before that could be written as

=PROPER(TRIM(CONCAT(P42#)))

If you carry on this approach, this will eventually result in our monster formula, viz. 

=PROPER(TRIM(CONCAT(IF(INDEX(IF(ISNUMBER(VALUE(MID(F12,SEQUENCE(1,LEN(F12)),1))),1,),SEQUENCE(1,LEN(F12)))=INDEX(IF(ISNUMBE
R(VALUE(MID(F12,SEQUENCE(1,LEN(F12)),1))),1,),SEQUENCE(1,LEN(F12),0)),MID(F12,SEQUENCE(1,LEN(F12)),1),""&MID(F12,SEQUENCE(1,LEN
(F12)),1)))))

Word to the Wise

Dynamic arrays are only supported in Microsoft 365 and Excel on the 
Web presently.  If you have an earlier version of Excel, the suggested 
solution here will neither display correctly nor calculate appropriately.  In 
this case, you will have to revert to VBA (e.g. as User Defined Function), a 

third party add-in or Power Query.  You can’t use LAMBDA either!

For the time being!

Until next time.
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Upcoming SumProduct Training Courses - COVID-19 update
Due to the COVID-19 pandemic that is currently spreading around 
the globe, we are suspending our in-person courses until further 
notice.  However, to accommodate the new working-from-home 
dynamic, we are switching our public and in-house courses to 
an online delivery stream, presented via Microsoft Teams, with 
a live presenter running through the same course material, 
downloadable workbooks to complete the hands-on exercises 
during the training session, and a recording of the sessions for 

your use within 1 month for you to refer back to in the event 
of technical difficulties.  To assist with the pacing and flow of 
the course, we will also have a moderator who will help answer 
questions during the course.

If you're still not sure how this will work, please contact us at 
training@sumproduct.com and we'll be happy to walk you 
through the process.

Location Course Date Date Duration Duration

Online (Australia) Excel Tips and Tricks 6 Oct 2021 09:00-17:00 AEDT (-1 day) 22:00-07:00 GMT 1 Day

Online (Australia) Financial Modelling 7 - 8 Oct 2021 09:00-17:00 AEDT (-1 day) 22:00-07:00 GMT 2 Days

Online (Australia) Power Pivot, Power Query and Power BI 3 - 5 Nov 2021 09:00-17:00 AEDT (-1 day) 22:00-07:00 GMT 3 Days

Online (Australia) Excel Tips and Tricks 10 Nov 2021 09:00-17:00 AEDT (-1 day) 22:00-07:00 GMT 1 Day

Online (Australia) Financial Modelling 11 - 12 Nov 2021 09:00-17:00 AEDT (-1 day) 22:00-07:00 GMT 2 Days

Online (Australia) Power Pivot, Power Query and Power BI 8 - 10 Dec 2021 09:00-17:00 AEDT (-1 day) 22:00-07:00 GMT 3 Days

Online (Australia) Excel Tips and Tricks 15 Dec 2021 09:00-17:00 AEDT (-1 day) 22:00-07:00 GMT 1 Day

Online (Australia) Financial Modelling 16 - 17 Dec 2021 09:00-17:00 AEDT (-1 day) 22:00-07:00 GMT 2 Days

Link to Others
These newsletters are not intended to be 
closely guarded secrets.  Please feel free 
to forward this newsletter to anyone you 
think might be interested in converting to 

“the SumProduct way”.

If you have received a forwarded 
newsletter and would like to receive 
future editions automatically, please 

subscribe by completing our newsletter 
registration process found at the foot of 
any www.sumproduct.com web page.

Any Questions?
If you have any tips, comments or queries 
for future newsletters, we’d be delighted 
to hear from you. Please drop us a line at 

newsletter@sumproduct.com.

Our Services
We have undertaken a vast array of 
assignments over the years, including:
· 	 Business planning
· 	 Building three-way integrated 		
	 financial statement projections
· 	 Independent expert reviews
· 	 Key driver analysis
· 	 Model reviews / audits for internal 	 	
	 and external purposes
· 	 M&A work
· 	 Model scoping
· 	 Power BI, Power Query & Power Pivot
· 	 Project finance
· 	 Real options analysis
· 	 Refinancing / restructuring
· 	 Strategic modelling
· 	 Valuations
· 	 Working capital management
If you require modelling assistance of any 
kind, please do not hesitate to contact us 
at contact@sumproduct.com.

Training
SumProduct offers a wide range of 
training courses, aimed at finance 
professionals and budding Excel experts. 
Courses include Excel Tricks & Tips, 
Financial Modelling 101, Introduction to 
Forecasting and M&A Modelling. 

Drop us a line at training@sumproduct.com 
for a copy of the brochure or download  
it directly from 
www.sumproduct.com/training.

Check out our 
more popular 
courses in 
our training 
brochure:

Key Strokes
Each newsletter, we’d like to introduce you to useful keystrokes you may or may not be aware of.  This year, we thought we’d revisit each 
function key in depth (there are 12 – one for each month of the year!).  Given it’s now October, let’s look at the F10 tips.
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Keystroke What it does

F10 Activate menus

CTRL + F10 Toggle maximised / restored

SHIFT + F10 Activate context menus (right-click)

ALT + SHIFT + F10 Show On-Object User Interface (OOUI)

Hey, it’s not our fault so many do the same thing this month!

There are c.550 keyboard shortcuts in Excel.  For a comprehensive list, please download our Excel file at
www.sumproduct.com/thought/keyboard-shortcuts. Also, check out our new daily Excel Tip of the Day feature on the 
www.sumproduct.com homepage.


